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HD32MTLogger Software Manual for the instrument HD32MT.1 
Introduction 
WARNING: The software must always be run as administrator! 
The HD32MTLogger program allows management of the HD32MT.1 datalogger from your PC. 
Using this software you can manage: 

• datalogger programming; 
• data transfer to PC; 
• graphic presentation and printing of captured measurements; 
• display of measurements in real time, also graphically. 

The data logged in the instrument internal memory can be downloaded on the PC, saved on file, 
printed, and exported in Excel. 
The software has an automatic search function of the devices connected to the PC. 
For the instrument complete features, please see the printed manual or the PDF file available in the 
Documentation section of the CD-ROM. 

 

HD32MTLogger Start up 

Start the application by double clicking on the application icon on the desktop, or select the 
HD32MTLogger item in the DeltaOhm folder on the Start menu. 
If you have an Internet connection, the program first checks for a new software update asking if you 
wish to install it. If no Internet connection is detected or no software update is available, the warning 
is not displayed and the main page appears. 
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You can see the following areas: 
1. Menu: it collects the menu items. 
2. Command Bar: a set of icons of the main commands of the application. 
3. Folder Window: it displays the PC folders and the default work folder. 
4. File Window: all files contained in the folder selected in the Folder Window (point 3). 
5. Properties Window: shows the characteristics of the file selected in the File Window (point 4). 
6. Status Bar: provides information on the serial connection and the connected instrument. 

The areas can be resized by dragging the borders with your mouse. 
The use of the application sections and available commands is illustrated in detail in the following 
paragraphs. At the end of the manual you can find the complete list of commands with a short 
description, in order to provide a quick guide to the various functions. 

 

Connection 

Connect the datalogger, through the COM PC port, to the PC. The datalogger can be connected in 
the following ways: 

• directly to an RS232 port of the PC using the 9CPRS232 cable, 

• directly to an USB port of the PC using the C205 cable (fitted with built-in USB/RS232 
converter), 

• using a Radio Modem (only for the version with Radio Modem option), 

• through a Local Area Network with TCP/IP protocol (inserting a RS232/Ethernet adapter 
between the network and the datalogger). 

For the details on the various connection options, please see the instrument's operating manual. 

Direct or Radio Modem connection configuration 
If the datalogger is connected directly to a RS232 or USB port of the PC, or it is connected through a 
Radio Modem, select the Serial Connection item in the Tools menu to configure the connection. 

 

In the Connection Properties window, check the RadioModem item for the model with Radio Modem 
option. For the basic model, ensure no check is present, or click on the small box near the item to 
deselect it. 



3 / 62 

 

Select the number of the COM port of the PC to which the instrument or modem is connected, then 
press Apply to return to the main window. If the port number is unknown, do not change the setting 
and press Apply to exit. The program will automatically search for an instrument connected to the 
PC's available ports, starting from the set one. The remaining communication parameters cannot be 
changed; the difference between the two datalogger models consists in the data transfer speed (bit 
per second): 38400 for the Radio Modem model and 115200 for the basic model. 

Configuration of network connection with TCP/IP protocol 
If the datalogger is connected through a Local Area Network with TCP/IP protocol, select the TCP/IP 
connection setup item in the Tools menu to configure the connection. 

 

In the TCP/IP connection setup window, set the IP address and Port fields as required by the used 
RS232/Ethernet adapter (please see the adapter documentation). 
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Press Apply to store the configuration. Press Exit to return to the main window. 

Choice of instrument model and connection type 
Select the Choice of instrument model and connection type item in the Tools menu. 

 
Select the model HD32MT.1. Select Serial connection if the datalogger is connected directly to a 
RS232 or USB port of the PC, or it is connected through a Radio Modem. Select TCP/IP connection if 
the datalogger is connected through a Local Area Network with TCP/IP protocol. 
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Press Apply to store the choice. Press Exit to return to the main window. 

Starting the connection 
Make sure the instrument is powered, then select the Connect icon in the Command Bar, or the 
Connect item in the Tools menu. 

 

If the connection is successful, the software reads the program installed in the datalogger and 
displays the DataLogger Information window with datalogger model, serial number, firmware version, 
name of program installed in the datalogger, measurement acquisition interval and number of store 
tables (a store table is a list of measurements being logged together). 

 

Press OK to access the software's main window. Later, the DataLogger Information window can be 
opened from the main window by selecting "Tools >> Instrument info". 
Note: if you attempt connection while the datalogger is recording data in the SD memory card, you 
will get an error message. In such case, wait till the end of recording and retry by pressing Connect. 
A correct connection is indicated by a green label on the left of the status bar. In the status bar are 
also shown, in this order: current date and time (UTC), datalogger model, user code, serial number, 
name of the datalogger operation program, measurement acquisition interval (Scan Period) and 
number of store tables. 

 

If the connection fails, an error message is shown; in such case, check the serial connection's cables 
and settings. 
At the end of the connection, before removal of the cables, select the Disconnect icon in the 
Command Bar, or the Disconnect item in the Tools menu. 
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Default work folder 

All files processed by the software are saved into a folder called Predefined folder. The software, 
during installation, creates the Deltaohm\HD32MTLogger default work folder in the installation disk's 
root.  
When first opening the software, the work folder contains only the Setup subfolder. The datalogger 
measurement and logging programs are saved in this subfolder. 
When first connecting the datalogger, also the Logging and Monitor subfolders are created. The 
data downloaded from the instrument connected to the PC are recorded in the first, the second 
gathers the data acquired by the Monitor function. 
The Logging and Monitor folders are identified according to the serial number of the connected 
datalogger. This allows keeping the data from different dataloggers separate, and therefore handling 
multiple dataloggers using the same software (you can connect only one instrument at a time; you 
cannot simultaneously monitor multiple dataloggers). 

 

To change the work folder name and position, you can use the Predefined folder command in the 
Tools menu. 
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The following window opens: 

 

Press Change... and select the new folder, then confirm with OK.  
Press Apply to close the window. To have the change take effect, you need to close and restart the 
application. 
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Clock Setup 
To update the date and time of the instrument, select the Clock Setup icon in the Command Bar, or 
the Clock Setup item in the Tools menu. 

      
The following window will appear: 

 
At the top of the window, under the HD32MT title, you can see the datalogger date and time, for the 
reference time zone (UTC). 
In the Time Zone field, select the time zone of your location. 
At the bottom of the window, in the PC Clock section, you can see the PC date and time, for the local 
time zone and the reference time zone (UTC). 
Press SET to set the instrument to the same date and time of the PC. 
Even though the time of the datalogger is always referred to the reference time zone (UTC), to the 
data in the internal memory and downloaded into the PC is assigned the local time, calculated 
according to the set time zone. Inserting the correct time zone information is essential. 
Press EXIT to return to the application main window. 
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User code 

To view and set the user code of the instrument, select the User Code Setup icon in the Command 
Bar, or the User Code Setup item in the Tools menu. 
 

 
 
The following window will appear: 
 

 
 
To modify the user code, write the new code and press Apply. 
 
Press Exit to close the window without code changes. 
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Download of captured data 

The datalogger continues to log since the moment an operation program containing store 
tables is transferred. If the datalogger has no operation program with at least one store table, 
the measurements are not recorded, and therefore you cannot download any data. 
The data captured by the instrument can be transferred to the PC for display and processing. 
Select the Dump LOG icon in the toolbar or the Dump LOG item from the File menu. 

 

The following window will appear: 

 

The store tables can be downloaded one at a time. The application does not allow simultaneous 
download of multiple tables. 
At the top of the window, select the number of the table to be downloaded. The quantities contained 
in the selected table are listed under the selection field. 
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At the bottom of the window, the name to be assigned to the file is prompted, composed of number of 
store table followed by a sequential number. To the file is assigned the d32 extension. The file will be 
saved in the Logging folder inside the default work folder. If you wish to change the file name or path, 
select Browse, then write the file name and indicate the folder in which to save the file. 

 

Finally, indicate if you wish to download all data in the memory for the selected table (All Data option) 
or only those recorded after the last download (New Data option). 
Note: the first time the data are downloaded, it is necessary to select the All Data option, 
otherwise an error message will be displayed. After the first data download, it will be possible to 
select the New Data option as well. 
To start the data transfer press Start. 

 

The transfer status is indicated by a progress bar at the bottom of the window. You can cancel the 
transfer pressing Abort. 

 

At the end of the transfer, press OK to return to the application main window. 
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The file concerning the downloaded data will be listed in the Logging folder (If the default path was 
maintained, otherwise you should look the other path indicated when saving). 

 

 

Monitor  
To display the values measured by the instrument in real time on the PC's monitor, select the Monitor 
icon in the toolbar, or the Monitor item from the File menu. 

 
The window Monitor will appear, containing the same number of windows of the quantities measured 
by the datalogger. Per each quantity the name, unit of measurement and corresponding input 
channel are reported. Moreover, the last measured quantity is displayed numerically. 
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Note: the measure of the transmitters connected to the analog inputs is always displayed using 4 
figures, independently of the measured quantity. The Pt100 sensors configured on a low scale have a 
centesimal measurement. The Pt100 sensors configured on a high scale, the NTC sensors and the 
thermocouples have a decimal measurement.  
By selecting the second icon up on the left, you can select if laying the quantity windows in drop-
down order, vertically or horizontally. 

 

You can minimize each single window or minimize all of them by selecting Minimize All. 
By selecting (check mark present) or deselecting (check mark absent) the View Graphs and View 
Data items, you can view the last acquired measurement both numerically and graphically for the last 
900 captured values in real time, or view the last measurement only numerically or graphically for the 
last 900 captured values in real time. 

 

The trends are shown starting from "0" and are scrolled leftwards on the PC's monitor. The graph's 
horizontal axis shows the number of captured values in real time. 
By selecting the Beep item, an acoustic signal is issued (if the PC's audio is on) each time the values 
on the screen are updated after a capture. 
By positioning the mouse on a graph point, you can view the acquisition time and the value at that 
point. 
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By "clicking" with the right button of the mouse, you will get the following list of commands: 

 

Copy: it copies the graph to the clipboard. 
Save Image As...: it saves the graph as a bitmap image in emf, png, gif, jpg, tif or bmp format. 
Page Setup...: it allows setting up the page format in order to print the graph. 
Print: it prints the graph. 
Show Point Values: it enables or disables the display of the acquired values when the mouse 
pointer is placed on a point of the graph. 
Un-Zoom: it cancels the previous zoom. 
Undo All Zoom/Pan: it cancels all zooms. 
Set Scale to Default: it adapts the vertical scale for the measured values, that is, it applies the 
maximum zoom to allow a complete view of the trend. 
Note: the Un-Zoom and Undo All Zoom/Pan commands are enabled only after the Set Scale to 
Default command. 
To exit the Monitor function, select the first icon up on the left: 

 
Before exiting, you are prompted if you wish to save the values captured in real time from the start of 
the Monitor function. By answering Yes, the values are saved into a file with d32 extension in the 
Monitor folder contained inside the default work folder. The file is identified by the date and time of 
exiting from the Monitor function. 
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View and export the saved data 

The Logging data downloaded from the datalogger and the data captured using the Monitor function 
and saved in the PC can be directly recalled and analyzed with the HD32MTLogger program, or 
exported in Excel format. 
To recall the data saved on the PC, select the Monitor folder for the data acquired with the Monitor 
function or the Logging folder for data downloaded from the datalogger memory. Then select the file 
containing the data to be displayed in the list of files. 

 

In the Description of selected file box you can view the quantities in the file. At the bottom of the box, 
the complete path, number of store table, recording interval, date and time of the first and last 
acquisition, total number of samples present in the file are indicated. 
To open the file of the measurements double click on the name of the file, or select the file and click 
with the right button of the mouse, then select Explore. 

 

To select the acquisition sessions saved outside the default folder, select the Tree view of the 
directory command and indicate the path of the measurement file. 
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As an alternative, select the View Data icon in the toolbar, or the View Data item in the File menu, 
then select the desired file and press Open. 

 

When the file is opened, the following window appears: 

 

In the upper left box, the list of detected quantities and the correspondent graph colour will appear. 
The upper right box displays the acquired measurements as a table. 
When the window is opened, only the graph of the first quantity of the list is displayed. To display or 
hide the graph correspondent to a quantity, click on the small box on the left of the quantity name in 
the upper left panel, so to make the tick mark appear or disappear. 
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ZOOM FUNCTIONS 

It is possible to change the y-axis scale of each graph, or to apply a zoom to enlarge particular areas 
of the graph. The graph panel can be enlarged to fit all the View Data window. 
  

How to enlarge the graph panel 

In the upper side of the window, select the sixth icon from the left. 

 

The graphs area will occupy all the available window. To reduce the graph area, select the same icon 
again. 
  

How to modify the scale 

In the right side of the upper left panel, select the quantity of which you want to change the scale. 

 

Select X1 to change the scale with 1 unit steps, or X10 to change it with 10 units steps. 

 

Then: 
• select the arrow keys to shift the scale upwards or downwards. 
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• select the "+" and "-" keys to decrease or increase the full scale value of the y-axis. 

 

• change the values in the Max and Min fields to precisely set the max and min of the scale. 

 

  

Zoom 

To enlarge a part of the graph, left click on the outer side of the area, keep the button pressed and 
draw the mouse until you draw a window around the desired area, then release the button. 

 

The selected zone will now occupy the entire graph area. 
If you have a mouse with a central wheel, the graph can be enlarged and reduced by rotating the 
wheel forward or backward. 
To return to the previous zoom levels, click with the right button of the mouse, to get the following list 
of commands: 

 

then select: 

Un-Zoom: to return to the previous zoom level. 

Undo All Zoom/Pan: to return to the initial graph view. 

These commands are enabled only when a zoom was applied to the graph. 
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In addition to the functions to cancel the zoom, by clicking with the right button of the mouse you will 
get the following list of commands: 

Copy: it copies the graph to the clipboard. 

Save Image As...: it saves the graph as a "bitmap" image in "emf", "png", "gif", "jpg", "tif" or "bmp" 
format. 

Page Setup: it allows setting up the page format in order to print the graph. 

Print: it prints the graph. 

Show Point Values: it enables or disables the display of the acquired values when the mouse 
pointer is placed on one point of the graph trends. 

 

Set Scale to Default: it adapts the vertical scale for the measured values, that is, it applies the 
maximum zoom to allow a complete view of the trends. 
  

GRAPHS SETTINGS 

It is possible to change the background color of the graphs area, the axes color, the color and the line 
thickness of each graph. 

How to change the background color 

In the upper side of the window, select the fourth icon from the left. 

 

In the colors table that appears, select the desired color and press OK. 

How to change the axes color 

In the upper side of the window, select the third icon from the left. 

 

In the colors table that appears, select the desired color and press OK. 
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How to change the line thickness of the graphs 

In the upper side of the window, select the fifth icon from the left. 

 

Select Increase lines thickness or Decrease lines thickness to enlarge or reduce the graphs lines. 
  

How to change the color of the graphs 

Select the colored bar next to the quantity name. 

 

In the colors table that appears, select the desired color and press OK. 
  

PRINTING DATA 

The displayed data can be printed by selecting, in the upper side of the window, the first icon from the 
left. 

 

The data are printed in the table format that appears in the upper right panel. 
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EXPORTING DATA 

The displayed data can be exported in Excel format by selecting, in the upper side of the window, the 
second icon from the left. 

 

After some seconds you will get a message confirming the export completion, with indication of the 
saving folder. The exported file is created in the same folder of the source data file. 
  

DELETING FILES 

If you wish to remove a file, select it in the application main window, click with the right button of the 
mouse, then select Delete. 

 

  

UPDATING THE FOLDERS CONTENT 

If the folder content is not updated after removal, creation or download of files, click with the right 
button of the mouse in the files window and use the Refresh command, or select the Refresh icon in 
the toolbar. 
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ERRORS 

In the Errors column, in the upper left panel, all the measurements acquisition errors are reported. To 
view the errors list correspondent to a quantity, select the related Errors filed. 

 

The red number on the right of the filed indicates the total number of errors occured while acquiring 
the correspondent quantity. 
Selecting a row in the errors list, the data table row with the selected error is automatically 
highlighted. 

 

Importing data files from FTP and memory card 

Using the HD32MTLogger software you can download measurement files from FTP and/or SD 
memory card and copy them in the corresponding folders in the default folder. 

Importing files from FTP 
If the datalogger is fitted with a GSM module and has been configured to send the measurement files 
to an FTP address, you can copy these files into a subfolder of the default folder. To import 
measurement files from an FTP address you need a PC connected to Internet. 
Select the Import icon in the toolbar (or the Import item from the Tools menu), then the Import from 
FTP item. 

 

In the window that opens, select the FTP Setup folder. 
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In the FTP Setup folder, set the following parameters: 

ftp Server: enter the FTP address. 

ftp User: enter the user name to access the FTP service. 

ftp Password: enter password to access the FTP service. 

ftp Folder Path: enter the folder path on the FTP server for the data coming from the 
datalogger (the path must end with the slash "/"). 

 

Note: the values shown in the pictures are only an example. The fields should be filled by the user 
according to the information provided by the FTP service provider. 
After setting the FTP parameters, select the FTP Files folder.  
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Select the Connect icon. 

 
In the left box of the window you will see the list of data files sent by the datalogger. 
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Select the file you wish to copy, then select the right arrow icon. 

 

The files will appear in the right box, ready to be copied. In the left box the files will appear over an 
orange background, to highlight the files already selected for transfer. 

 

To select all files in the FTP folder, press the double right arrow icon. 
If you wish to remove some files in the right box, select them and press the left arrow icon. 
To remove all files in the right box, press the double left arrow icon. 
To copy the files listed in the right box to the default folder, select the Download Data icon. 
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At the end of the copy you will get a message confirming the correct transfer, press OK to continue. 
The file copied will appear over a green background. To close the Import from FTP window, press the 
Exit button. 

 

The files are copied into a subfolder identified by the datalogger's serial number and the FTP 
indication. The files are separate according to the date of the measurements; a subfolder is created 
per each date (e.g. the DO101227.LOG subfolder refers to the measurements captured on the 27th 
of December 2010). 



27 / 62 

 
If the data refer to multiple dataloggers, a subfolder is created per each datalogger sending data to 
that FTP address. 
The original files are not removed from the FTP server. If you wish to remove any file from the server 
after copy to the default folder, select it in the Import from FTP window's left box, then press Delete 
icon. 

 
You will be prompted to confirm the permanent removal of the file. 
To update the FTP Files list with possible further files sent by the datalogger to the ftp server after the 
connection, press Refresh. 
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Importing files from SD memory card 
To copy the data files recorded on the SD memory card to the default folder, extract the memory card 
from the datalogger and insert it in the PC's card reader. 
Note: do not remove the memory card when the datalogger is writing (red LED), to avoid damaging 
the card contents. 
Select the Import icon in the toolbar (or the Import item from the Tools menu), then the Import from 
SD card item. 

 

In the window that opens, select the data file folder inside the memory card from the left box. 

 

Select the right arrow icon. In the right box of the window you will see the list of files contained in the 
selected folder. 

 

To copy the files listed in the right box to the default folder, select the Download Data icon. 
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Note: all files listed in the right box are copied; you cannot select and copy single files. 

At the end of the copy you will get a message confirming the correct transfer, press OK to continue. 
To close the Import from SD card window, press the Exit button. 

 

The files are copied into a subfolder identified by the datalogger's serial number and the SD 
indication. The files are separate according to the date of the measurements; a subfolder is created 
per each date (e.g. the DO101227.LOG subfolder refers to the measurements captured on the 27th 
of December 2010). 

 

If the data refer to multiple dataloggers, a subfolder is created per each datalogger. 
Note : when importing files from the memory card, the original files are not deleted. To free some 
space in the card, it is necessary to delete the files manually using Windows Explorer. 
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Merging imported files 
The Merge Files function allows joining into a single file the hourly files for the same store table. This 
operation creates a new file containing all measurements from the single hourly files, the original files 
are not modified nor removed. 
To use this function, proceed as follows: 

1. From the HD32MTLogger application main page, select, in the folder box, the folder with the 
copied files. 

 

2. Select the Import icon in the toolbar (or the Import item from the Tools menu), then the Merge Files 
item. 

 

3. You will be prompted to confirm the merging operation, press Yes to continue. 

4. At the end of the merging operation you will get a confirmation message. The new file is created in 
the same folder of the hourly files. 
The operation automatically merges all hourly files of the same store table present in the folder. You 
cannot manually select the files to be merged. 
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Programming the datalogger 

The datalogger acquires and records the measurements only if configured for the connected sensors. 
The configuration consists of installing in the datalogger an acquisition and recording program for the 
measurements detected by the sensors. 
If the datalogger has already an acquisition and recording program, you can change and replace it, if 
necessary. 
The creation or modification process of the datalogger's configuration consists of the following 
stages: 

• connecting the datalogger to the PC; 
• opening the measurement acquisition and recording program file; 
• configuring the inputs; 
• defining the store tables; 
• creating the file to be transferred to the datalogger; 
• transferring the acquisition and recording program to the datalogger; 

Note: you need to first connect the datalogger to the PC only if you edit the measurement acquisition 
and recording program already present in the datalogger (e.g. the program installed by Delta OHM, in 
case you requested an already configured datalogger). If you create a new program or edit one 
saved in the PC but not installed in the datalogger, you only need to connect the instrument to the PC 
before the measurement acquisition and recording program transferring phase. 
To connect the datalogger to the PC, please see the Connection paragraph. The next steps are 
illustrated below. 
  

Opening the measurement acquisition and recording program file 

Select the Program Setup icon in the toolbar or the Program Setup item from the Tools menu. 

 

The following window will appear: 
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Select: 

OPEN Program, to open an existing measurement acquisition and recording program 
saved in the PC; 

NEW Program, to create a new measurement acquisition and recording program; 

RUNNING Program, to edit the acquisition and recording program installed in the 
datalogger (this option is available only if the datalogger is connected). 

If you select OPEN Program, you will get the window to select the file to be opened. The files have an 
ini extension. Select the file and press Open, you will get the selected acquisition and recording 
program window. 
If you select NEW Program, you will be prompted for: 

• name to be assigned to the acquisition and recording program file (Program Name): it 
should start with a letter and can contain only letters, numbers, the character "_" and 
the period "." (that cannot be the last character of the name); 
• the measurement acquisition interval (Scan Period): from 1 to 60 seconds (preset to 
1s, can be changed also later). 

 
Enter the needed information and press OK, you will get the acquisition and recording program 
window. 
If you select RUNNING Program, you will directly get the window of the acquisition and recording 
program installed in the datalogger. 
  

Configuring the inputs 
After opening the acquisition and recording program window, you can add new sensors, remove 
sensors or edit the exiting sensors' parameters. 
The available input configurations are divided in three categories: 
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• Universal Measurements  
- Unipolar Voltage : single-ended voltage measurement  
- Bipolar Voltage : differential voltage measurement  
- Resistance divider : 2-wire resistance measurement or 3-wire potentiometric measurement 
- Resistance Divider 4Wire : 4-wire resistance measurement 
- Adder Pulses : pulse count or clean contact switching 
- Input Current 4-20 and 0-20mA : current measurements 
- Digital Input : detection of TTL logic levels 
- Modbus RTU : acquisition of sensors with RS485 output and Modbus RTU protocol 

• Environmental Analysis  
- U.S. Anemometers HD2003 : measurements of the HD2003 and HD2003.1 anemometers  
- U.S. Anemometers HD52.3D : measurements of the HD52.3D series anemometers  
- Rain Gauges : measurement of rain quantity  
- Radiometry : measurement of solar radiation 

• Industry  
- Pt100-Pt1000 Thermometers : temperature measurement with Pt100-Pt1000 probe  
- Thermocouples : temperature measurement with thermocouple probe  
- NTC Thermistors : temperature measurement with NTC thermistors  

To add a sensor to the measurement acquisition and recording program, proceed as indicated below: 

1. In the above list of input configurations, find the type of configuration corresponding to the sensor 
to be connected. 

2. In the program window, ensure the Sensors panel is selected on the left (when opening the 
window, the panel is the default one). 

 

3. Expand the Sensors folder and then the folder of the category containing the type of configuration 
to be added (e.g. Industry if you are adding a temperature probe). Then select the type of 
configuration (e.g. Thermocouples) and click on the Add Measure green arrow button at the center of 
the window (or double click on the configuration name). 
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4. The configuration window will open. Here, you can enter all required parameters. 

 

Fill all editable fields (only those with white background) according to the sensor features. All 
configuration windows have three common fields: 

- The Name field to enter an identification name for the sensor (e.g. the sensor model or 
the type of measured parameter). The name should begin with a letter and can be 
maximum 12 characters long. 

- The field of the parameter's unit of measurement. This field is usually under the Name 
field. According to the type of sensor, the unit of measurement can be selected from a 
drop down menu or entered freely. In this second case, it should begin with a letter and 
can be maximum 12 characters long. 

- The Channel field. It shows the datalogger input number to which the sensor should 
be connected. The input is assigned automatically, you cannot manually change it. 

The remaining fields depend on the selected type of configuration. Later in the paragraph, the 
parameters of each type of sensor are comprehensively illustrated. 

Note: to cancel the sensor input, select the small cross up to the right. 

5. In the right box of the window (MEASURE List) you will see the added sensor with the 
configuration data. 
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Repeat the procedure on each sensor to be connected to the datalogger. Each new sensor is added 
at the bottom of the list of sensors already entered. 
Note: if a sensor measures multiple quantities and has multiple outputs you need to repeat the 
procedure per each output you wish to connect (as with distinct sensors). 
To modify the parameters of an existing sensor, double click on the sensor line in the list of the right 
box (MEASURE List). 
Note: the double click to edit the existing parameters is enabled only when the Sensors panel is 
selected in the left box. 
To remove an existing sensor, you only need to select it in the right box and press Remove Measure 
at the bottom of the box. 

 

When pressing Remove Measure you are prompted to confirm the removal (message Do you wish to 
remove this measure?), press Yes to confirm. 
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Description of the various inputs parameters 

For a description of the configuration windows per each type of datalogger input, select the following 
links: 
• Universal Measurements  

Unipolar Voltage: single-ended voltage measurement  

Bipolar Voltage: differential voltage measurement  

Resistance Divider: 2-wire resistance measurement or 3-wire potentiometric 
measurement  

Resistance Divider 4Wire: 4-wire resistance measurement  

Adder Pulses: pulse count or voltage-free contact switching  

Input Current 4-20 and 0-20mA: current measurements  

Digital Input: detection of logic levels 

Modbus RTU: acquisition of sensors with RS485 output and Modbus RTU protocol 

• Environmental Analysis  
U.S. Anemometers HD2003: measurements of the HD2003 series anemometers  

U.S. Anemometers HD52.3D: measurements of the HD52.3D series anemometers  

Rain Gauges: measurement of the rain quantity  

Radiometry: measurement of solar radiation  

• Industry  
Pt100-Pt1000 thermometers: temperature measurement with Pt100-Pt1000 probe  

Thermocouples: temperature measurement with thermocouple probe  

NTC Thermistors: temperature measurement with NTC thermistor 
  
Warning Messages 
When entering the sensors you can get the following messages: 
• Scan Period too short !: this message appears when the number of sensors is too high in order to 
capture all measurements within two subsequent acquisition periods. The measurement you are 
trying to enter will not be added to the list of measurements. Press OK to return to the application 
window. To enter additional measurements you need to increase the scan period. 

• The Unipolar Channels n. 1, 2 or 3, 4 aren't available !: this message appears when the unifilar 
inputs 1, 2, 3 and 4 are already used and you are trying to insert sensors such as Resistance 
Dividers and NTC Thermistors that can be connected only to those inputs. To insert the sensor you 
should free one of the inputs, removing from the list the associated sensor using the Remove 
Measure command. 
• Not other free Channels !: this message appears when you are trying to insert a sensor but no more 
inputs are available for that type of sensor. 
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Store tables 

After defining the list of measurements (MEASURE List) and the acquisition interval (Scan Period), 
you should define the measurements to be recorded in the datalogger and when. 

It is important to be aware that the measurement acquisition process and the recording 
process are distinct in the datalogger. The definition of the list of measurements and of the 
acquisition interval alone does not entail the automatic recording of the captured data. To 
record a measurement you need to input it into a store table. 
 
A measurement acquisition and recording program can be composed of one or more store tables. 
The use of multiple tables allows recording of the various measurements at different intervals. 
To define the first store table, proceed as follows: 

1. In the left panel of the program window, select the Table n.1 folder by clicking on the relative tab. 

 

Note: the folder can be selected only if the list of measurements (MEASURE List) has at least one 
sensor. 

2. In the left panel you will get an empty table. To input a measurement, select it from the list in the 
right panel (MEASURE List) and click on the Add Store blue arrow at the center. 

 

3. You will get a window allowing to choose what to record for the selected measurement. Select the 
desired option amongst the available ones. The possible selections are the following: 
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• OneSample: it records the last measured value. 
• Average: it records the average of the captured measurements between two 
subsequent recording instants. 
• Max: it records the maximum value of the captured measurements between two 
subsequent recording instants. 
• Min: it records the minimum value of the captured measurements between two 
subsequent recording instants. 
• Total: it records the sum of the captured measurements between two subsequent 
recording instants. It is usually used in case of impulsive inputs to record the total pulse 
count. 
• StDeviation: it records the standard deviation of the captured measurements between 
two subsequent recording instants. 
• Alarms: it records the alarm condition for the measurement. 

Note: according to the type of measurement, some options could be disabled if not important for that 
particular type of measurement. The Alarms key is disabled if the table already contains a type of 
recording that is different from an alarm condition (please see the Alarm Table paragraph). 

4. After selecting the type of information to be recorded, the measurement is added to the store table. 
After input of the first measurement, you will see the recording interval box over the table (Store 
Period). Write the desired interval. If necessary, select minutes or seconds for the interval unit of 
measurement. 

 

The recording interval (Store period) should conform to the following conditions: 

• Being within 2 and 60 seconds or between 1 and 1440 minutes. 

• Being equal or greater than the measurement reading interval (Scan Period). In 
case it is greater, it should be an integer multiple of the reading interval. 
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The input recording interval is associated to the table, that is, it is valid only for that definite table and 
not for any possible other table that will be added. Moreover, the recording interval is the same for all 
table measurements, that will therefore be recorded together on the same instant. 
If you set a non-multiple recording interval of the reading interval you will get an error message: Store 
Period must be multiple of Scan Period !. In such case, press OK and set a correct value for the 
interval. 
5. Proceed as above to add further measurements to the store table. 

If you wish to record some measurements at different intervals, you can divide the measurements in 
multiple tables, setting the required interval per each table. 
The same measurement can be present in more tables. 
If you have a lot of measurements to be recorded according to the same interval, you can, for your 
convenience, divide them in multiple tables, setting the same recording interval for the various tables. 
To create the next table after the first you need to select New Table, down to the left of the 
application window. 

 

By pressing New Table you will automatically get an empty table to input the desired measurements. 
The program can contain up to 8 store tables. 
To remove the last created table, select Delete Table under it. 

 

You can only remove the table with the highest sequential number. You cannot remove table number 
1, even if empty. 
To remove a measurement from a table, select it and press Remove store. 
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Note: if the measurements are many and the acquisition interval (Scan Period) is short, the 
datalogger could not be capable of recording all measurements between two subsequent acquisition 
instants. In such condition, you will get the warning message Scan Period too short !. In this case, 
increase the acquisition interval value. 
  
Alarm Table 
To create an alarm table, select an empty table, then add the desired measurements by selecting 
Alarms. 
Selecting the Alarms option, you will get the window that allows to set the values of the two alarm 
thresholds, lower (Low Value) and higher (High Value). 

 

Select the Enable boxes to enable the thresholds. The alarm condition occurs if the measured value 
is below the lower threshold or over the higher threshold. 
You can assign a corresponding alarm output to each threshold. The alarm outputs are independent 
for the two thresholds. You can use the I/O digital ports as alarm outputs, selecting Ch IO or voltage-
free contact alarm outputs, selecting the Ch ALARM option. The output number, indicated to the left 
of the option, is automatically assigned by the software. Manual setting is not allowed. If you do not 
wish to assign an alarm output, select NO Out. If you do not select an output option, the software 
automatically assigns the NO Out option. 
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Each alarm output corresponds to one threshold only. You cannot assign the same output to two 
different thresholds, even if relative to the same measurement. 
The alarm conditions are always recorded according to the logging interval set for the table, 
independently of the assignation of the corresponding outputs. 
If the datalogger is connected to a GSM device, when an alarm condition occurs the datalogger can 
send a warning SMS. The SMS text consists of the text entered in the field General, followed by the 
text (not editable) of the Event Low or Event High field depending on the alarm condition present. 
Press OK to add the alarm conditions to the table. 
The alarm conditions that you wish to record should all be entered in the same table. The table 
dedicated to log the measurement values cannot contain the records of alarm conditions. If a 
table contains the record of a measurement value, the Alarms button is disabled when adding new 
measurements to it. Similarly, a table logging alarm conditions cannot contain measurement values. 
If a table already contains the record of an alarm condition, only the Alarms button is enabled when 
adding new records to it. 
You can change alarm conditions already entered by double clicking on the rows of the table 
(note: the SMS text is visible only if the sending of the SMS is enabled). 
An hysteresis equal to ±1% of the set value is applied to the alarm thresholds. The difference 
between the two thresholds cannot be lower than 2% of the lower threshold value. 

Alarms related to digital inputs: 
In the case of digital inputs, only one thresholds can be enabled. Enabling the lower thresholds, there 
is the alarm signal when the input is at logic state 0. Enabling the higher thresholds, there is the 
alarm signal when the input is at logic state 1. If both thresholds are enabled, an error message 
appears when pressing OK to confirm. 

 
By selecting the Edge Trigger box, the alarm is triggered only after a state change of the input signal 
(from 1 to 0 if the lower thresholds is enabled, from 0 to 1 if the higher thresholds is enabled). This 
allows to prevent false alarms at system power on: if the digital input is in the alarm state at 
datalogger power on, the alarm is not triggered immediately but the datalogger waits for the alarm 
condition to stop and occur again later (with the Edge Trigger box not selected, instead, the alarm 
would be triggered immediately at power on). 
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Enabling the SMS: 
To enable the sending of the SMS you should check the Enable SMS option. 

 

The Repeat field allows setting the time interval for sending any subsequent alarm SMS, in case of 
persisting alarm condition. 
After an alarm condition has occured and the correspondent SMS has been sent, no more SMS will 
be sent until the set Repeat interval, even if new alarm conditions should occur. If when sending the 
alarm SMS, more than one alarm condition is present, only the SMS concerning the first alarm 
condition is sent. 
After the Repeat interval, if the alarm condition is not present any more, the SMS is not sent. 
The SMS sending interval is the same for all measurements. The alarm SMS sending is only 
available on the first 16 measurements of the table. 
To set the telephone numbers to which the SMS messages should be sent, please refer to the GSM 
Setting chapter.  
Note: SMS are not sent if the datalogger is connected to the PC and a communication session is 
occurring. 
 
  

Creating the file to be transferred to the datalogger 
After defining the list of sensors (MEASURE List) and the store tables (STORE Tables), with the 
relative acquisition (Scan Period) and logging (Store Period) intervals, you should save the 
acquisition and recording program file to the PC, in order to transfer it to the datalogger. Proceed as 
follows: 

1. Press Create. 

 
The window allowing to indicate the file name and path to save it to the PC is displayed. At the end of 
the saving, you will get a summary report, press OK to return to the application window. 
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2. Check that the time (in days) needed to fill the datalogger internal memory, down to the right in the 
program window, is enough for your application. 

 
3. Select Print to print the wiring diagram and/or the store tables. 

 

Then select Print Wiring Diagram to print the wiring diagram or Print Tables Store to print the store 
tables. Press OK. 

 

4. Press Exit to close the window of the acquisition and recording program. 
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Using the Create button, the program is saved in more versions with the same name but different 
extensions. In particular, a file with "ini" extension and a file with "img" extension are generated The 
file with "img" extension contains the program in a format that can be read by the datalogger, and is 
therefore the file to be transferred to the datalogger. The file with "ini" extension contains the program 
in text format, and is the file being opened by the HD32MTLogger software when the program needs 
to be edited. 
To save the program without generating the file to be transferred to the datalogger, e.g. because you 
did not yet finish, select directly the Exit button instead of Create. The software will prompt for the 
name and path to save the file and will save only the "ini" format. 
If you wish to edit a previously saved program before transferring it to the datalogger, select the 
Setup Program command in the main window of the HD32MTLogger software, then select OPEN 
Program, select the previously saved program (file with "ini" extension) and press Open. 
Note: if you select Create with empty store tables, you will get a warning message: No STORE 
Tables or empty Tables, confirm creating ?. If you continue, the file for the datalogger will be created 
anyway, but such program will only perform measurements without saving. 
 
  

Transferring the acquisition and recording program to the datalogger  
To make the acquisition and recording program operational you need to transfer it to the datalogger. 
Warning: the transfer of a program to the datalogger erases all data in the internal memory. So as not 
to loose the recorded data, you should transfer them to the PC using the Dump LOG command of the 
HD32MTLogger software, before beginning the program transfer procedure. 
To transfer the program to the datalogger, connect it to the PC (please see the Connection 
paragraph) and proceed as illustrated below: 

1. Select the Send Program icon or the Send Program item from the Tools menu. 

 

2. In the window that opens, select the name of the previously saved program (with "img" extension) 
and press Open. You will get a message to remind that the recorded data will be lost. Press Yes to 
continue. 

3. Wait for the program to be transferred to the datalogger (a progress bar will indicate the transfer 
status). 
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At the end of the transfer the DataLogger Information window will be displayed. Press OK to exit. The 
transferred program will automatically begin to function in the datalogger, acquiring and recording the 
set measurements. 

4. To end the communication session between PC and datalogger, select the Disconnect icon. 

Note: if a measurement acquisition and recording program is already present in the datalogger, it will 
be erased at the beginning of the new program transfer. In case of connection problems interrupting 
the transfer (some error messages are displayed), the datalogger remains without a measurement 
acquisition and recording program. In this case, you need to repeat the transfer operation from the 
beginning. 

 

GSM settings 

If the datalogger is connected to a GSM module, the system can send an SMS alarm message to 
mobile phones, and information on the recorded data via Internet to e-mail and FTP addresses. 

Note: in order to send data via e-mail and FTP, the datalogger should have an SD memory card, as it 
transmits the data recorded on the card. 
The information necessary for the module function should be set using the GSM icon in the toolbar, 
or GSM Settings item from the Tools menu. 

 

Note: the GSM setting command is disabled if a connection was started using the Connect 
command. In this case, end the connection using the Disconnect command to enable the setting of 
the GSM options. 
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Note: if the datalogger is writing or transmitting data, after selecting the GSM command you will 
receive a message that the datalogger is not available; in this case, wait some seconds and repeat 
the operation. 
Note: if after selecting the GSM command you will receive the message " It is not possible to connect 
to the GSM module ", make sure the SD memory card is properly inserted. 

When entering the GSM configuration, the data in the datalogger internal memory will be 
erased. By selecting the GSM setting command, you will get a message to remind that the data will 
get lost: press OK if you wish to continue, or cancel the operation and download the data in the 
memory before proceeding to configure the GSM. The erased data are only those in the internal 
memory, the files present in the SD memory card are maintained. 
By answering OK to the warning message, you will get the GSM Options window. The options are 
divided in the following sections: 

Starting settings (Connection user name and password, SIM PIN, APN access point) 

e-mail settings (e-mail sender "account" configuration) 

ftp Settings (information on FTP server to which the data are sent) 

e-mail addresses (input of the receivers' e-mail addresses) 

SMS recipient (input of the phone numbers for alarm SMS) 

File settings (selection of the data to be sent via e-mail and/or FTP) 

In addition to the configuration sections, you have three sections allowing to check the system 
functioning by sending test information to the phone numbers and addresses specified in the 
configuration sections: 

Test SMS (sending test SMS to the specified phone numbers) 

Test e-mail (sending test e-mail to the specified addresses) 

Test FTP (sending test file to the specified FTP address) 
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Starting settings 

 

Note: the values shown in the pictures are only an example. If the GSM options have never been set, 
the fields are empty and should be filled by the user according to the information provided by the 
telephone service provider.  
The Starting settings section is composed of the following fields: 

User name connection : write the connection user name supplied by your mobile telephone provider. 

Password connection : write the connection password supplied by your mobile telephone provider. 

PIN of the SIM : write the PIN code of the SIM card inserted in the GSM module. 

Access Point Name APN : enter the name of the APN access point to the network supplied by your 
mobile telephone provider, for data sending via e-mail and/or FTP. 

Datalogger Identifier : indicate a user code to be associated to the datalogger. The code can be 
chosen by the user and can be maximum 32 characters long. 
If the GSM module is connected to the datalogger and is functioning (powered and with SIM card 
inserted), apply a check near GSM Present to activate the functions of SMS transmission to mobile 
phones and data sending via e-mail and/or FTP. 
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If the GSM module is connected and functional but, for some reason, you wish not to activate the 
SMS and data transmission, do not apply the check mark. The GSM options will be saved anyway in 
the datalogger. 
If the GSM module is not connected or functioning, do not apply the check mark to avoid the 
datalogger attempting to communicate with the module generating error messages. 

e-mail settings 

To allow the datalogger to send e-mails you have to associate an e-mail "account". The information 
concerning the account are entered in the e-mail settings section. 

Note: the values shown in the pictures are only an example. If the GSM options have never been set, 
the fields are empty and should be filled by the user according to the information provided by the 
e-mail service provider. 

 

The section is composed of the following fields: 

Sender e-mail address : enter the e-mail address of the account used to send e-mails; this address 
will appear as sender name in the e-mails sent by the datalogger. 

User Account for e-mail : enter the user name of the account. 

Password of e-mail account : enter the access code of the account. 

Address of smpt server : enter the output e-mail server name as indicated by your e-mail service 
provider. 

e-mail smpt port : enter the port number of the e-mail output server as indicated by your e-mail 
service provider. 
Apply a check mark near e-mail Authentication to authenticate the e-mails sent by the datalogger. 
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ftp settings 

To allow the datalogger to send files to an FTP address, you need to set the server access 
information in the ftp settings section. 

Note: the values shown in the pictures are only an example. If the GSM options have never been set, 
the fields are empty and should be filled by the user according to the information provided by the FTP 
service provider. 

 

The section is composed of the following fields: 

ftp Server : enter the name of the FTP server as communicated by your service provider. 

ftp User : enter the user name to access the FTP service. 

ftp Password : enter password to access the FTP service. 

ftp Folder Path : enter the folder path on the FTP server for the data transferred from the datalogger. 

ftp Port : enter the port number of the FTP server as communicated by your service provider. 
  



50 / 62 

e-mail addresses 

In the e-mail addresses section you can enter the addresses to which the datalogger will send the 
files with the recorded data. The files are sent as e-mail attachments. The maximum size of the 
e-mail attachment is 100KB. 

Note: the values shown in the pictures are only an example. If the GSM options have never been set, 
the fields are empty. 

 

The e-mail address entered in the Hidden recipient e-mail address field will not be visible to the other 
receivers. 
To avoid mailing errors you need to enter the e-mail subject in the Object of message field. 
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SMS recipient 

In the SMS recipient section you will enter the phone numbers for the alarm SMS. You can enter up 
to 4 numbers. 

Note: the values shown in the pictures are only an example. If the GSM options have never been set, 
the fields are empty. 

 

The SMS content is set in the alarm table of the datalogger acquisition and recording program. 
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File settings 

In the File settings section, you can select the store tables to be sent via e-mail and/or FTP. 

 

In the Tables to be sent via ftp and Tables to be sent via e-mail boxes, select the store tables you 
wish to send. The data files being sent are those recorded in the SD memory card. The presence of 
the SD memory card in the datalogger is therefore an essential condition to send the data via e-mail 
and/or FTP. You cannot send the data recorded in the datalogger internal memory after the last 
writing to the SD card. 
If you select multiple tables to be sent via e-mail, a separate e-mail is sent per each table. 
The datalogger creates in the SD card the files correspondent to the number of hours set in the filed 
Number of files to be appended (e.g. 4 hours if you set a number of files to be appended equal to 4). 
The files will be sent only at the end of the set number of appending operations. The SD card will 
contain only the appended files and not the single hourly files. 
The maximum data file size is 100KB if sent via e-mail and 1MB if sent via FTP. Please pay 
attention to file appending in order to avoid exceeding such limits. 
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Test SMS 

By selecting Test SMS you can check if the system can send the alarm SMS correctly. 

 

In the Send SMS field, enter the message that you wish to send. 
The SMS is sent to the phone numbers previously entered in the SMS recipient section. 
Press the Test SMS button to send the message, then check that the SMS has been correctly 
received. 
Note: if the GSM module is not connected or functioning, do not press the Test SMS button to avoid 
the datalogger attempting to communicate with the module generating error messages. 
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Test e-mail 

In the Test e-mail section you can check the correct sending of the e-mails with the recorded data. 

 

The test e-mails are sent to the addresses previously entered in the e-mail addresses section. 
Press the Test e-mail button to check if the e-mails have been correctly received. 
Note: if the GSM module is not connected or functioning, do not press the Test e-mail button to avoid 
the datalogger attempting to communicate with the module generating error messages. 
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Test ftp 

In the Test ftp section you can check the correct sending of the recorded data to the specified FTP 
address. 

 

The data files are sent to the address previously entered in the ftp settings section. 
Press the Test ftp button, then check if the files have been correctly received. 
Note: if the GSM module is not connected or functioning, do not press the Test ftp button to avoid the 
datalogger attempting to communicate with the module generating error messages. 
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Transferring the settings to the datalogger 

The setting changes performed in the GSM options window will be enabled after pressing the SET 
button. Until you press SET, the edited fields have a green background to show that the changes 
have not yet been saved in the datalogger. 

 

After selecting SET, you will be prompted to confirm the new configuration of the GSM device, press 
OK, and then EXIT to close the GSM options window. 

 

Software language  

To change the software language, select the Language item in the Help menu, then choose the 
desired language. 
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Info  
For further information about the software version and license terms, and to open the program 
manual, select the Help menu. 

 
The online Help can be opened quickly by selecting the question mark icon in the toolbar. 

 
 

GSM firmware update 

The program (firmware) that manages the GSM can be updated using the function GSM Firmware 
Loader in the Tools menu. 
To request firmware updates, if available, please contact Delta Ohm. 
Procedure:  
1. Using the 9CPRS232 cable, connect the COM AUX port of the instrument to the computer in which 
the HD32MTLogger software is installed. 
2. Turn the instrument on. 
3. In the Tools menu , select GSM Firmware Loader. 

 
4. Select the number of the COM port of the PC to which the instrument is connected and set the 
Baud Rate to 115200.  
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5. Use the Browse... button to select the update file with extension " bin " copied into a PC folder. 

 

6. To start updating, press Start. 

 

7. At the end, you will see the message Uploading executed correctly. 

 

The update is now complete. 
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Datalogger firmware update 

The program (firmware) that manages the datalogger can be updated using the function HD32MT 
Firmware Loader in the Tools menu. 
To request firmware updates, if available, please contact Delta Ohm. 
 
Procedure:  
 
1. Copy the update file with extension " mot " into the software installation folder. 
 
2. Using the 9CPRS232 cable, connect the COM PC port of the instrument to the computer in which 
the HD32MTLogger software is installed. 
 
3. Turn the instrument on. 
 
4. In the Tools menu , select HD32MT Firmware Loader. 

 
 
5. Select the number of the COM port of the PC to which the instrument is connected and set the 
Baud Rate (38400 for the Radio Modem model and 115200 for the basic model). 
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6. To start updating, press Download. 

 
 
 
7. At the end, press Exit. 
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Command icons 

 

Connect 
It connects the datalogger to the PC (available only if the instrument is not 
connected).  

 

Disconnect 
It disconnects the datalogger from the PC (available only if the instrument is 
connected).  

 

GSM 
It configures the GSM transmission.  

 

View Data 
It opens a data file saved in the PC.  

 

Dump LOG 
it transfers to the PC the data stored in the instrument.  

 

Monitor 
It captures the measurements from the datalogger to the PC in real time.  

 

User Code Setup 
Viewing and setting of the user code. 

 

Clock Setup 
Setting of the instrument date and time.  

 

Program Setup 
It creates or modifies an operation program in the datalogger. 

 

Import 
It imports the files from FTP and SD memory card; it merges the hourly files in the 
memory card. 

 

Send Program 
Transfer of an operation program to the datalogger. 

 

Refresh 
It updates the folder contents. 

 

Help 
It opens the program manual. 

 

Exit 
It closes the application or the open window. 
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Menu items 

File >> View Data: view of data files saved in the PC. 
File >> Dump LOG: transfer to the PC of the data stored in the datalogger. 
File >> Monitor: view in real time on PC's monitor of values measured by the instrument.  
File >> Exit: close the program. 

  
Tool >> Serial Connection: setting the PC direct serial connection parameters. 
Tool >> TCP/IP Connection setup: setting the parameters for PC network connection with TCP/IP 

protocol. 
Tool >> Choice of instrument model and connection type: selection of data logger model and 

selection between direct serial connection or through network.  
Tool >> Connect: connecting the datalogger to the PC (command available only if the datalogger is 

disconnected). 
Tool >> Disconnect: disconnecting the datalogger from the PC (command available only if the 

datalogger is connected). 
Tool >> GSM settings: configuring the GSM transmission. 
Tool >> Clock Setup: setting the instrument date and time.  
Tool >> User Code Setup: viewing and setting of the user code. 
Tool >> Program Setup: creation or modification of an operation program in the datalogger.  
Tool >> Import: importing files from FTP and SD memory card; merging hourly files in the memory 

card. 
Tool >> Send Program: transferring an operation program in the datalogger.  
Tool >> Instrument info: viewing the information for the connected instrument. 
Tool >> Predefined folder: setting of the work folder path to which the data are saved. 
Tool >> GSM Firmware Loader: updating of the GSM firmware. 
Tool >> HD32MT Firmware Loader: updating of the datalogger firmware. 
  
View >> Toolbar: enabling or disabling the display of command icons. 
View >> Status Bar: enabling or disabling the display of status bar information. 
View >> Tree View: enabling or disabling the display of the Folder Window. 
View >> View details: viewing of the list of files in the folders with date, size and type of file. 
View >> View icons: viewing of the list of files in the folders as icons, without file details.  
  
Help >> 32MTLogger Manual: opening of the program manual. 
Help >> 32MTLogger License: viewing of the program user license. 
Help >> Language: selects the software language. 
Help >> About...: viewing of the program version. 
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